SimCalc’s MathWorlds for Revision of Linear Functions/Introduction to velocity and rates of change

The RITEMATHS folder contains adapted files from Java Packages 2003 from the SimCalc Project. 

Save the RITEMATHS folder in C:\Program Files\JavaMathWorlds\Resources

Section 1: Representing motion with position/time graphs

Start up JavaMathWorlds Version 2.5 and maximize the window.

From within MathWorlds, open the file intro1.mw  from the RITEMATHS folder. (seen below)

The windows (ie Controls, Actor Info and Numeric Display) shown can be found under the Window Menu if not visible at startup. 

If windows disappears – look at lower task bar or revisit the drop down windows menu

Shaded boxes are suggested class activities – other boxes are hint notes for teachers

	Explain that the World is a stylized lift moving up and down a building and the graph represents its journey. It shows where the lift is located at any time in the journey.

Ask students to draw a diagram of such a building and what might be on each floor eg. Myers main store, hospital etc.
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	Notice:

- movement of the lift 

- changing values in the Numeric Display window.

- line tracing the journey on the position graph.

- the position graph with two line segments is minimized ( bottom left hand corner)
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	Click the green arrow [image: image3.png]2
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 in the Controls window to animate the lift.  Note the changing values on the Numeric Display. Animate as often as necessary.

Students should now attempt No. 1 on Worksheet 1

Open the file intro2.mw  from the RITEMATHS folder . Run the animation again focusing on the graph.

Remember the control window is available from the windows menu.


You will see that the lift leaves marks (as seen below). This is because the Marking is ON in the Actor window. These marks are used to work out the velocity of the lift. The Step Time is set to 1 in the Controls window (expand Controls window with the little arrow bottom left corner). The lift leaves a mark every step. So if the marks are 2 floors apart, then the velocity is 2 floors per second.
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 Reset the animation by clicking the red rewind arrows.  Always  reset after each animation.

The animation can also be observed by stepping through. 
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 Clicking the little yellow feet on the right of the Controls window will step through the animation one step at a time.


	In order to have the students fully understand the situation, draw a diagram of the situation on the black/white board. ie.

                
[image: image7]

	Then, have a pair of students come out to the board – one controlling the lift (use an eraser) and the other drawing in the graph as the lift moves.

E.g.  as the lift moves up the building at 1 floor per second the graph is drawn in.

Repeat this with other pairs of students drawing different situations.

E.g. start the lift at the 2nd floor, moving up the building at 2 floors per second etc.


	Step through the animation again, asking your class appropriate questions. 

For example, 

Time interval – what is it?  1 what – 1 second? What is it in real life?  

(Initially use this scale – high speed – could change scale later to match real life if required)

1. [image: image18.jpg]


On which floor is the lift after 3 steps? 

2. On the graph, What is this point? What does it mean?

3. On what floor does the lift start its journey?

4. On which interval is the lift going the fastest? 

5. How fast is the lift going for each part of the trip (on each interval) ie. First time interval? Second time interval? 

6. How many floors does the lift go in 1 second? 

7. How is this related to the slope of each segment?

Step through the animation again, with students recording, in a table, the values form the Numeric Display.

Ask:-.

8. What are the variables in this situation (ie what varies)?

9. What does each pair of values mean?

10. Which variable should go on the horizontal axis? 

Students should now do No. 2 on Worksheet 1


Section 2: Linking Symbolic Representation and Graphical Representation

Open the file linking.mw  from the RITEMATHS folder. (seen below) The windows (ie Controls, Algebra and Numeric Display) shown can be found under the Window Menu if not visible at startup

The movement of the lift can also be controlled symbolically. The expression for the function can be changed in the Algebra window and these changes are reflected in the movement of the lift.  
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	Notice:

-There are 2 lifts

-Only one at a time can be manipulated via the ‘Actor  window’ .

-For this exercise make sure Actor B is active.

- The green (B) lift’s movement can be controlled via Algebra window.

[image: image9.png]File Actor Simulation View Window Help

Floors Floors

—

3}

| Zac NG eNE S







The Algebra window (above) shows a linear function in the form y=mx+c, where x is the time elapsed, y is the floor number. The Initial Value is the floor the lift starts on (i.e. the y-intercept). The co-efficient of the (number which goes with) x term is the slope (rate of change ie the change in floor per second). The values in the brackets at the bottom show the starting and the end times for the journey [or the domain of the function].

	Discuss the parts of the Algebra window. Remind students that the function is a linear function in the form y=mx+c  

Show the Table (located on the Window menu)
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Demonstrate the following steps. 

(Remember rewind after each animation)

1. Run the animation to compare your algebraically defined motion for the green (B) lift with the given movement of the red (A) lift. 

2. In the Algebra Window, fill in the Initial Value, the Slope of the linear segment and the End Time for the function. Notice that the change in the Algebra window changes the movement of the lift and changes the Table.

3. Repeat the editing as needed till the movement of the red (A) lift and the green (B) match exactly, using Marks and Stepping as needed.

4. Write your formula for green (B) lift’s Position function and sketch its graph.




Graph can be drawn by hand on the board or prepared as a handout by pressing [print screen] key and paste to a Word file, add notes save and print.

	Students can repeat these steps 1-4 above for all challenges at each level in the file symbolic.mw (Questions 1 – 4 for on Worksheet 2).


The movement of the lift can also be controlled graphically using hot spots. Hot spots are shown on a graph by a small black square. These hot spots can be dragged vertically or horizontally to change the graph.

By dragging the hot spots on the Position graph for the red (A) lift, the movement of the red (A) lift can be changed.  The hot spot on the vertical axis controls the starting floor; the hot spot on the horizontal axis controls the time and the hot spot on the right hand end of the line segment controls the finishing floor.

	With the Table window open, change its movement graphically (by dragging hotspots) so that the Red (A) goes from the 1st basement floor to the 8th  floor in 6 seconds. 

Now switch control to the green (B) lift, by selecting B from the Actor window.

By changing the values in the Algebra window for the green (B) lift, make it start at the same Time as the red (A) lift and go from the 2nd floor to the 8th floor—meeting up with the red (A) lift at the end of its journey.

Students should now attempt the rest of the questions on Worksheet 2 using in the file graphically.mw.


Section 3: Average Rate of Change: 

Open the file velocity.mw  from the RITEMATHS folder. (seen below)
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	Notice:

- Velocity graph with hot spots

- some new buttons in top right hand corner

- 4 of these are:-

[image: image12.png]IMW: velocity.m

File Actor Simulation Option Window Connect

Floors

Floors/Second

¥ Selected Function: B

)

222 )

RS e m ]

=1





Erase one segment 

Erase all segments

Add velocity segment
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Change between position and velocity graphs




	Change to position graph by clicking  [image: image14.png]& JWW: average.mw
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Open the Algebra window and emphasise the connection between the co-efficient of the x term and the velocity.


We want to generate a 2 segment Velocity graph  so that the lift starts at the ground floor, getting to the 12th floor with two different Velocities—slow for the first part of the journey, and then fast for the rest of the journey. Don’t worry about how long it takes.

	Do this by adding a second Velocity segment and then adjust the two Velocity graph segments’ width and height, on the graph, so that the lift travels slowly for the first part of its journey to the 12th floor, and quickly for the second part of the journey. (More than one answer is possible, eg.  2 floors per second for 4 seconds followed by 4 floors per second for 1 second)

Discuss possible solutions with your students. How long did the journey take?

Step through the animation, with students recording, in a table, the values from the Numeric Display.

Uncheck the Snap-to-Grid in the View menu, how many ways are now possible?


Remove a segment. We are looking for a single velocity segment to represent the average rate of change over the entire time of the animation. (ie reach the 12th floor in the same time)

	Ask:-  

What single velocity segment will enable the lift to reach the same final floor in the same time as the two segment graph? Demonstrate.

Students should now attempt questions 1 – 3 for Worksheet 3.


Open the file average.mw  from the RITEMATHS folder
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	Notice:

- position graph with hot spots
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Add a position segment




	Look at the Table found in the Windows menu.

Consider the difference between successive values for the red (A) lift. 

Switch to the Velocity graph.

Compare the graph with the differences. What do you notice?



	With assistance drawn from your class, add as many position segments as necessary and adjust them using the hotspots so that the lift travels from the second floor, stopping for 2 seconds at each floor until it reaches the sixth floor, then returns to the ground floor in 6 seconds.

Run the animation as often as necessary to complete the task.

Now switch to Velocity graph view and uncheck Snap-to-grid.

What single velocity segment takes the lift from the second floor to the sixth floor in the same time?

Students should now attempt the rest of the questions for Worksheet 3.


Section 4: Different Contexts

Having firmly grounded the students’ understanding of the concepts in one context (ie lifts) we are now going to consider different contexts.
	Students should now attempt the questions on the Worksheet 4


Section 5: Building Meaning for Equations and Solving Equations

Open the file velocity.mw  from the RITEMATHS folder

	How long would it take the lift to reach the 6th floor? 9th floor?

Write these questions as equations. (ie velocity x time =  ? floor, eg. 3t=6)



	Draw the Position graph corresponding to the Velocity graph shown.  

i.e.

 How can you use this graph to solve the equations?
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	Add a second Velocity segment and then adjust the two Velocity graph segments’ width and height so that the lift gets to the 12th floor, but quickly for the first part of the journey and slowly for the second part.

Ask your students:-

What is the Total Area between the Velocity segments and the Time-axis? 

How does this Area compare with the Total Area under the two segments initial problem? 

Students should now attempt the questions 1 – 4  on Worksheet 5.

Open the file velocity2.mw  from the RITEMATHS folder

Write out the journey as equations for the total distance travelled.

i.e. Write out the equations as a sum in the form: 

Total distance traveled 
= Area under first segment + Area under second segment 

= (V1) * (T1) + (V2) * (T2), 

where V1 and T1 are the Velocity and Time for the first segment and V2 and T2 are the Velocity and Time for the second segment. (NB. include the units).

 E.g. 2 fl/sec * 4 seconds + 4 fl/sec * 1 seconds = 8 floors + 4 floors = 12 floors

Students should now attempt questions 5&6 on Worksheet 5


Solving Equations

	Open the file equations.mw  from the RITEMATHS folder

Suppose a lift started at the 2nd floor, and traveled at 1 fl/sec for 3 seconds, and then 3 fl/sec for X seconds, ending on the 11th floor. How many seconds did it travel at 3 fl/sec?

We can write an equation that represents this situation:

2 floors + 1 fl/sec * 3 seconds + 3 fl/sec * X seconds = 11 floors

This equation states: Initial Position + Distance Traveled = Final Position

This equation can be solved in a number of ways – graphically (trial and error running the animation), numerically (trial and error trying numbers for X), or formal methods — show and discuss each method

Students should now attempt questions 7 – 9 on Worksheet 5.


Simultaneous Equations 

	Open the file simultaneous.mw  from the RITEMATHS folder

Run the animation focusing on the lift.

Ask :-

When are the lifts at the same floor?

Step through the animation to check.

Maximise the position graph

Run the animation focusing on the graph

Open the Table 

Run the animation focusing on the table

Open the file simultaneous1.mw  from the RITEMATHS folder

Ask :-

When are the lifts at the same floor?

Step through the animation to check.

Maximise the position graph

Run the animation focusing on the graph

Open the Table 

Run the animation focusing on the table.

Students should now attempt remaining questions on Worksheet 5.


� This material has been adapted from the curriculum materials developed by the SimCalc project and available at http://tango.mth.umassd.edu/
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